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System Requirements

The following information outlines the minimum and recommended system requirements to run Alastri Haul
Infinity. As the hardware required depends on the complexity of the mine and the amount of data, meaningful
minimum requirements cannot always be listed. Ultimately the only way to know whether specific hardware will
work for a specific mine site is to validate the software's performance during the free trial period.

e  Forlarge multi-pit mines with raw LIDAR surfaces and block models with 80M blocks the requirements will
be at the extreme end.

e The minimum requirements will only support small mines with a small block model and surfaces with low
triangle counts.

e Please note that as our software develops over time, these requirements may change, and hardware
upgrades may become necessary.

Note: Running Alastri Haul Infinity on minimum system requirements may slow the application response,
depending on the size of the model. Use recommended requirements for optimal use.

Component Minimum Standard Extreme
Processor Intel i5 Intel i7 Intel i9
Memory (RAM) 8 Gb 64 Gb 128 Gb
Operating System Windows 10 x64 Windows 10 x64 Windows 10 x64
Video Memory (GRAM) 2Gb 8 Gb 12 Gb
Monitor 1920 x 1080 Dual 1920 x 1080 Triple 1920 x 1080
Video Connection HDMI, DisplayPort, DVI, VGA - USB not supported
Video Driver Driver no more than 6 months old (OpenGL 4.6+)
Hard Drive Solid State Drive with at least 50 GB Free
Power Connection AC Power - Battery power not supported (plug in the laptop)
Network Connection Consistent, reliable, high speed (>1 MB/s) connection to the Internet
Software Prerequisites .NET 4.7.2
Microsoft Visual Studio 2019 C++ Redistributables
(https://aka.ms/vs/16/release/vc redist.x64.exe)
Microsoft Excel
Input Devices Keyboard and Mouse with a left mouse button, right mouse button, and middle
mouse button/scroll wheel

"Element Not Found"

Many IT departments block downloads of Microsoft prerequisites, so you may need to download them manually.
The installation error "Element Not Found" indicates that you must download and install these manually.

e  Microsoft .NET Framework 4.5.1
e  Microsoft VSTO Runtime for Office 2010



https://aka.ms/vs/16/release/vc_redist.x64.exe
http://go.microsoft.com/fwlink/?LinkId=322116
http://go.microsoft.com/fwlink/?LinkId=158917

Installation and Setup

Prerequisite

It is important to note that the System Requirements should be met to run the software.

Many IT departments block downloads of Microsoft prerequisites, so you may need to download them manually.
If any error whatsoever occurs on install, ensure that you have downloaded and installed these manually.

e  Microsoft .NET Framework 4.5.1

Haul Infinity requires Windows 10 or higher (64 bit only)
Installation
Follow these steps to get started with Alastri Haul Infinity.

Alastri Login

New users may proceed to the licensing page and click Register as a new user. Please check your inbox for a
confirmation email to finalise your account.

¢ alastri

# Dastbosrd

:

. ST

Get Licensed
Choose from the following options to license your account with chosen Alastri products.

e Ask your manager to log in as a License Admin and add you to the company license, or
e Email support@alastri.com.au for assistance.

Download the Hub

The Hub manages all Alastri product release versions and licenses. It can be downloaded by logging
into the licensing page and pressing Download Alastri Hub.


http://go.microsoft.com/fwlink/?LinkId=322116
https://licensing.alastri.com.au/
mailto:support@alastri.com.au
https://licensing.alastri.com.au/

Install the Hub

Once the Hub has finished downloading, run the executable and click Confirm on security prompts to continue the

install.

E Alastri Hub 2.0.82.0 (x64) Setup — >

- Alastri Hub 2.0.82.0 (x64)

END-USER LICENSE AGREEMENT Revision 2.0- 22 April 2020 ~

Important - Read carefully:

This End-User License Agreement ("EULA") is a legal agreement between and
hinding each person using Alastri's software (“you” and “User”) and Alastri
Software Pty Ltd (“Alastri"). It applies to all Software Products made available

| agree to the license terms and conditions

Options & Install Close

Note that Alastri products will always be signed with "Verified Publisher: Alastri Software Pty Ltd".

Wait until the download is complete and click Close.

=HH Alastri Hub 2.0.82.0 (x64)

Installation Successfully Completed

Cloze

Even if you have administrative privileges you should install the Hub by right clicking on the Alastri.Hub.2.0.*.exe
file and run as administrator.



Login to the Hub

Double click on the Hub shortcut, or click Start > Alastri Hub, to open the Hub login form.

¢ Alastri Hub v2.0.77

¢;: alastri

Emad: | alastri.user@gmad.com

Password: Oy
Remember my password Logn Cancel
Forgot your login detads? Reset Password
Don't have an Alastni account? Create a New Account

GDFR Notice Optons  ~

Enter your email and password into the login form and press Login to continue.
The Hub uses the same password credentials as the licensing website. Passwords can be reset here.

Configure Proxy

If you are connecting through a company proxy, press Proxy Settings in the bottom right corner of the login form.

Emal;
:Ia}s.'.ﬂ' j. (EA EI R LS R R LR LY
Remember my password | L Caree
Fargol your o Geinly? Rl T Paggword

Dieari & Pl By ARSERN BOCoLnAT Creake & MNew Aooound

Prency Settings. [}
Clear Cache



https://licensing.alastri.com.au/Account/ForgotPassword
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Contact your IT department to obtain the correct proxy credentials for your organisation.

Install Products

In the main Hub form:

1. Select Haul Infinity from the left hand product menu.
2. Select the latest version.
3. Press Install.



Products [EEVRTINENH Alastri Hub v2.0.82 tSupport M Alastriv & lana Armstrong~ —

| m Haul Infinity I

I $=§ Haul Infinity

m Rapid Ressrver Mining Haulage Analysis Software
G Spatial Conformetrics

4 of 10 Seats Available
Tactical Scheduler

Current Active Users Time

You've been planning with this product for 501 hours

21.2.9681

Graphics & Compatibility

Graphics Card Settings

Follow these steps to ensure Haul Infinity runs smoothly on your computer. Note that your screen and settings
may differ from those shown here.

Check Your Graphics Card

Haul Infinity requires a dedicated graphics card by NVidia or ATl to run. To check your graphics card, go to
Windows Start > Control Panel > Hardware and Sound > Device Manager > Display Adapters.



L)

(_

Hardware and Sound

S % » Control Panel » Hardware and Sound »

Contrel Panel Home

System and Security
Network and Internet
Hardware and Sound
Pregrams

User Accounts

Appearance and
Personalization

Clock, Language, and Region

Ease of Access

Search Control Panel

v O

Devices and Printers
Add a device
Change Windows To Go startup options

Advanced printer setup | Mouse

G Devicel‘danﬁer

Play CDs or other media autematically

AutoPlay

Change default settings for media or devices

Sound

Adjust system velume | Change system sounds | Manage audio devices

Power Options

Change battery settings | Change what the power buttons de
Require a password when the computer wakes
Adjust screen brightness

Change when the computer sleeps

Display
Make text and other items larger or smaller
How to correct monitor flicker (refresh rate)

Adjust screen reselution

Windows Mobility Center

Adjust commaenly used mobility settings | Adjust settings before giving a presentation

NVIDIA Control Panel

Alienware Audio

Open the Control Panel and search for the Device Manager

s Device Manager

File Action View Help

&= @ E H=

> 0 Bluetooth
Q Cameras
> E Computer
Disk drives
Display adapters

> Firmware

=i Imaging devices
> B2 Keyboards

[ Monitors.
> I Network adapters

M Print queues
> [ Printers

n Processors

7 Security devices

r Software components

> B software devices

> G Storage controllers
> [ System devices

> P WSD Print Provider

NVIDIA GeForce RTX

A Human Interface Devices
> *@ |DE ATA/ATAPI controllers

L1 Memory technology devices
> . Mice and other pointing devices

Q‘ Sound, video and game controllers

i Universal Serial Bus controllers

Find the graphics card details listed under the Display Adapters




If you are running a computer without a dedicated graphics card, then you will need to upgrade your computer to
run Haul Infinity.

If you do have an appropriate dedicated graphics card, then proceed to the next step.

Update Graphics Drivers

Alastri products require the latest graphics card drivers for best performance.

L1\ Graphics Problem x

&) Outdated Graphics Card Driver

Driver for NVIDIA Quadro 6000 hasn't been updated since Wednesday, 27 May
2015.

You wil not be able to use this applicabon until you update your drivers.

NVIDIA Drivers: http://www.nvidia.com/Download/index.aspx?lang=en-us

v X

If you see this message, follow these links to download and run the latest graphics card drivers.

e NVidia Driver Downloads

e ATl Driver Downloads

e Intel Driver Downloads

Change the Default Graphics Processor

If any graphics related issues arise, navigate to the graphics card control panel and set Alastri products to run in
high-performance mode.

NVidia Graphics Cards

If you have an NVidia graphics card, it may be defaulting to the integrated graphics card instead of the higher
performance NVidia graphics card.

To change the default video card for Haul Infinity:

1. Right click on your desktop and select “NVidia Control Panel”.


http://www.nvidia.com/Download/index.aspx?lang=en-us
http://support.amd.com/en-us/download
https://downloadcenter.intel.com/

View
Sort by
Refresh

Paste
Paste shortcut
Undo Move

- NVIDIA Control Panel

New

T Display settings

&Y Personalize

2. Select “Manage 3D settings”.
3. Select “Program Settings”.

B nviDIA Control Panel - O X
File Edit Desktop 3D Settings Help

Qe - Q| B

Select a Task... .

=) 3D Settings Manage 3 D Sett] ngs
-Adjust image settings with preview Restore Defaults
BManage 3D settings

You can change the global 3D settings and create overrides for specific programs. The overrides will |
-Configure Surround, PhysxX each time the specified programs are launched.
= Display

Change resolution

Adjust desktop color settings
-Rotate display

-View HDCF status

-Set up digital audio

-Adjust desktop size and position
Set up G-SYNC

Set up multiple displays

I would fike to use the following 3D settings:

Global Settings Program Settings

1. Select @ program to customize:

’ﬁ 3DMark (3dmark.exe) ~ | | Add Remove

Shows only programs found on this computer

en

Adjust video color settings 2. Specify the settings for this program:

Adjust video image settings

System Information

Feature

Image Sharpening

Ambient Occlusion

Anisotropic filtering

Antialiasing - FXAA

Antialiasing - Gamma correction
Antialiasing - Mode

Antialiasing - Setting
Antialiasing - Transparency

CUDA - GPUs

Low Latency Mode
Max Frame Rate
Monitor Technoloay

Background Application Max Frame Rate

Setting

off

Not supported for this application

Use global setting (Application-controlled)
Not supported for this application

Use global setting (On)

Use global setting (Application-controlled)
Use global setting (Application-controlled)
Use global setting (Off)

Use global setting (Off)

Use global setting (All)

Use global setting (Off)

Use global setting (Off)

Use alobal setting (G-SYNC)




4. Choose “Haul Infinity” from the dropdown menu.
e  Or navigate to %localAppData%\Alastri Hub\Programs\PROGRAM\VERSION\3DMARK.exe.
5. Select your NVidia graphics card under "preferred graphics processor".

ATI Graphics Cards

If you are using an ATI graphics card, it may be defaulting to the integrated graphics card instead of the higher
performance ATI graphics card.

To change the default video card to Haul Infinity:

Right click on the desktop and open Catalyst Control Center.

Select “Power” from the left hand menu.

Select “Switchable Graphics” from the list.

Browse the list of programs and find Haullnfinity.exe (or C:\Program Files\Alastri Software\Alastri
Haullnfinity v21.2.981\ Haullnfinity.exe).

Set RapidReserver.exe to “High Performance”.

Apply changes and restart your computer.

PwnR

o v



Vulcan User Settings

These notes apply if you are importing surfaces from Maptek Vulcan. Haul Infinity requires Vulcan surfaces to be in
file format version 7.5 or earlier in order to import and use them.

In Vulcan, go to Tools > Preferences > File Types > Triangulations and change the file format to Version 7.5. Vulcan
requires a restart for the changes to take effect.

If you do not want to change Vulcan's formatting, use File > Export to DXF and import to Haul Infinity as a DXF file.

Waorkbench Triangulaticns
é!-V_uICan Explorer File Extentions
o File [¥] Auto update

Envisage
Dialogs and Popups
Graphics

Colours
i Effects
L Video Capture
—)- Defaults
2D Text
3D Text
Arrow
.. Dimension
- Miscellaneous
- Paths/Directories
- Plot All File Format
- Dragline Select format requires a restart of workbench to take effect.
- Ramps
- Drill & Blast
Draw by Hand
Plotting Utility

Haul Infinity requires Vulcan triangulations to be version 7.5



Surpac User Settings

These notes apply if you are importing surfaces from Geovia Surpac. Haul Infinity requires Surpac surfaces to be
saved in text format in order to import and use them.

Error{s) Encountered

X One or more files had problems in them as follows:

1: topo_final.dtm =3 Index was outside the bounds of the array.

This error message is caused by trying to import a Surpac DTM in binary format

Save File ot

Layer Mame topo_final. dtm

Filename d:\topo_final| v
Qutput Farmat Type | Surpac DTM Files b
Extension | .dtm i
Options...
File Farmak (®) text DTM[3DM Options
() binary Force solid validation on save

String Range Force rigid backwards compatibility

Purpose

Save styles []
Styles file name 5SI_STYLES:skyles,ssi

o ¥ Cancel

When saving surfaces in Surpac, set file format to text

Battery Power Settings

To prevent laptops from switching back to Intel graphics on lower power mode, go to Power Options > High
Performance > Advanced Power Settings and change all options to maximum performance.

Work Locally

Alastri recommends saving all project files and data on the local hard drive before transferring to the network. This
avoids issues with saving over interrupted connections or reading from a slow connection.



Work Offline
Licenses may be used offline by using the Extended Checkout feature in the Hub.

In the main Hub form:

1. Select an item from the left hand product menu.
2. Press Extended Checkout.
3. Enter the hours to checkout the license.
4. Press OK
Products [EGIGIGEL .8 Request Support [ Alas a Armstrong~ —

Haul Infinity

= =
a Production Scheduler H Hau' Inflnlty

m Rapid Reserver Mining Haulage Analysis Software

&, Dptions ~ B @ extended Checkout
G Spatial Conformetrics
5 of 10 Seats Available

|

Tactical Scheduler

Haul Infinity Extended Checkout

Use this form to check out the license for an extended duration.

Note that you cannot check a license back in early - it will
irrevokably be locked out for the duration of the checkout period that you
specify.

Checkout Duration (hours) m .

#  cancel 1Y oK

You've been planning with this product for 501 hours

Version: 21.2.981 f\}

Release Notes -
Install

v" This will lock the license to your machine (online and offline) for the duration of the checkout.

Note that license cannot be checked back in until the timer runs out.

Permissions

Users may encounter the "Access is denied" error message when attempting to open a project file via the Hub or
from Windows Explorer.



This error occurs when the helper process "PolygonicaService.exe" is blocked from running by a virus scanner, group
policy, or Windows compatibility profiles.

Virus Scanner

Virus scanners may block PolygonicaService.exe, or prevent it from launching. Adding a whitelist / exception for this
process can help avoid "Access Denied" errors.

The Alastri Hub installs products into the following location: %localappdata%\Alastri Hub\Programs.

Group Policy

Occasionally group policy configuration may prevent applications from being launched from AppData\Local on
machines.

Your IT administrators may need to provide an exception for Haul Infinity to allow it to operate correctly.
Program Compatibility Assistant

In order to allow legacy software to work on your system, your IT department may have created a program
compatibility profile which causes Windows to run applications with non-standard behaviour. This can affect Haul
Infinity’s ability to track instances of PolygonicaService.exe and make sure they are cleanly shutdown with the

application.

Your IT administrators may need to modify the application compatibility profile to avoid affecting Haul Infinity.

Warnings

Users may encounter the "Application Compatibility Profile" warning when attempting to install the Hub.



Application Compatibility Profile Detected

We have detected an application compatibility profile on your machine,
! s which may interfere with installation of Alastri Hub,

Would you like to disable this profile?

Keys found:

SOFTWARE\Microsoft\Windows
NT\CurrentVersion\AppCompatFlags\Custom\\HKEY_LOCAL_MACHIN
E\SOFTWARE\Microsofti\ Windows
NT\CurrentVersion\AppCompatFlags\Custom\setup.exe

Serious problems might occur if you modify the registry incorrectly. Contact your IT department to resolve this

issue.

v" If you are a competent IT professional:

Project Files

This issue may be resolved via the following steps:

1. Click on Start, type in "regedit" and run the command.

2. Browse to Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows
NT\CurrentVersion\AppCompatFlags\Custom.

3. Rename setup.exe to _setup.exe.

When Haul Infinity is saved, multiple different files will appear in the save location.

.inf
Jdock

.old
.resultCache

layers

.drapelmages

Haul Infinity project file

Locks out a file to one user at a time

If the main project files are corrupted for any reason, the “.old” files can be restored as
functional project files by removing “.old” from the file name

Reduces scheduling time by saving results of previous runs

Saves triangulations external to the main project. Deleting the “.layers” file is the same as
deleting all layers from the project

Saves draped images external to the main project. Deleting the “.drapelmages” file is the
same as deleting all draped images from the project



Internet License FAQ

Do | need an internet license?

Alastri software uses standard Internet-based authorisation. If you are in a remote location with a poor
connection, or no internet connection at all, then you may wish to enquire about dongle based authorisation.

How does my internet license work?

The internet license authenticates your purchase key, name and email against your details on the Alastri server.

Does the internet license require any special software?

The license does not require any special software to be installed.

How do | know if the license is working?

The licensing dialog will inform you of any authentication errors.

Can | check out my internet license overnight?

You can use the Extended Checkout feature to hold licenses offline for a number of hours. Normally the maximum
checkout time for licenses is seven days.

Checked out licenses cannot be released before their expiry date.

‘| Alastri Licensing — Lo ][

Licence Details

Purchase Key (ABCD-EFGH-1IKL-1234-5678)
MINE-ROCK-TECH-SERV-ICES
Your Name (First and Last Only)
Mine Rock Technical Services
Your Email Address
support@alastri .com.au|
License Server
www.alastri.com.au

Get Licence

Extended Checkout v

Requested Length in Hours
48

Note: ded check uts can't be checked-in early

Proxy Settings ~



Internet License Troubleshooting

Why is my license asking for browser authentication?

Your IT department may be restricting applications from connecting to the internet. In this case, Alastri connects
through a browser instead. Talk to your IT department about network permissions for Alastri products.

Why is my name not found?

The internet license authenticates your purchase key, name and email against your details on the Alastri server.
Check for spelling errors in your name; if problem persists then contact Alastri support.

; Licensing X

Error returned: Invalid Licence Details - Full name does not match user's last full name
Press OK to open the licensing page in your browser, or Cancel to change your details.

OK Cancel

..................................

Why is my email not found?

The internet license authenticates your purchase key, name, and email against your details on the Alastri server.
Check for spelling errors in your email, if problem persists then contact Alastri support.

| Licensing x
Error returned: Invalid Licence Details - alastri.com.au user profile with given email address was not found.

Press OK to open the licensing page in your browser, or Cancel to change your details.

Cancel




Why are there no available seats on the license?

Each Alastri license can be shared between a number of users. Ask your colleague if they can release the license for
your use.

Licensing X

Error returned: Invalid Licence Details - Floating license does not have any available seats,

Active Users:
Tim F,

Press OK to open the licensing page in your browser, or Cancel to change your details.

Cancel

What is "License tampering detected" and how can | fix it?

The internet licensing system checks to make sure that the computer's date and time is correct, to ensure that
checked out licenses expire properly. If you see this message, make sure that your computer's date and time is
updated.

What do | do if my license has expired?
Save and close your project and talk to your supervisor about renewing your license.
Hub Login Failure

Invalid Username or Password Entered

If the user encounters the Login Failed form, please re-enter your correct username and password.

Alastri Hub - Login Failed x

Q Invalid username or password. Check your details and ensure you have confirmed your email address.

..................................

..................................




Forgotten Password and Reset

Should the user forget their password, the Hub login form features the option for the user to Reset the password
(Reset Password button). This will take them to the Alastri website where the user can enter their email address.
An email will be sent to the entered email address with a password reset link.

Alastri Hub v2.0.77

*= alastri

Email:
F'ass'.-'l:lrlj: BEERERRREERREREE
Remember my password |+ Cancel
Forgot your login details? Reset Password
Don't have an Alastri account? Create a New Account
GDPR. Notice Options  ~

Forgot your password?

Enter your email address to request a password reset.

Email

™

reCAPTCHA

Privacy - Terms

I'm not a robot

Email Link

Unable to Connect

If the user is unable to connect to the Hub due to connection loss, several steps can be taken to try and rectify this.

If the user is presented with a Hub login screen that doesn't complete and seems to freeze, or a message
communicating No Connection, then most often the problem is on the user end with permissions blocking access

to the required files and web addresses.



50%
Getting Alastri products... Cancel

Forgot your login detais? Reset Password
Don't have an Alastri account? = Create a New Account

Confiqure Proxy..

Alastri Hub - No Connection X

Unable to establish an Internet connection. If you require a proxy, please configure it and try again.

Would you like to start the Hub in Offline mode?

Retry | Offline Mode Cancel

.....................................

Please try the following in order:

Open up a file explorer.

In the file path, type the following “%localappdata%”.
Go into the Alastri Hub Folder.

Go into the Cache folder.

Delete the contents inside.

Restart the Hub.

ounswNE

If still unable to connect this usually indicates that your connection is blocked and will require
intervention by IT.

1. To try and resolve this you will need to get IT to add https://alastribuild.azureedge.net/ to the whitelist.

2. Virus scanners will also need to allow Alastri access to the following address:
C:\Users\username\AppData\Local\Alastri Hub.

3. Try access the following link https://alastribuild.azureedge.net/media/rr/background.jpg. You should see
an image of an open pit operation.

4. Repeat Steps 1-6.

If still unable to access the Hub, try the following steps:

1. If you use a proxy you will need to enter the details.

Repeat steps 1-6.

3. IfyourIT team tell you they have an auto proxy and you still can't login, tell them to try specific proxy for
your machine.

4. Repeat Steps 1-6.

5. Contact Alastri.
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Dongle License FAQ

Do | need a dongle?

Alastri software uses standard Internet-based authorisation. If you are in a remote location with a poor
connection, or no internet connection at all, then dongle authorisation may be the best solution for your needs.

How do | obtain a dongle for my license?
Please contact Alastri Support to discuss your requirements.

How do | use the dongle?

The dongle does not require any special configuration to use. Simply insert the dongle into a USB port on the
computer and use the application as normal. In a normal state after the dongle is attached to the computer the
LED will be on all the time.

Do I still need to enter my purchase key?

Yes, every login requires authentication of your purchase key, name, and email address.
Does the dongle require any special software?

The dongle does not require any special software to be installed.

How many dongles do | require?

A single dongle is required per computer per license key. It is possible to share one license across multiple dongles.
Contact Alastri Support to discuss your requirements.

What do | do if | have lost my dongle?
Contact Alastri Support to discuss replacing your dongle.

How do | know the dongle is working?

Once a dongle is recognised by the computer, the dongle ID will show in the licensing dialog.



S Alastri Licensing - 0O x

Licence Details

Purchase Key (ABCD-EFGH-1IKL-1234-5678)
Your Mame (First and Last Only)
Your Email Address

License Server

www.alastri.com.au

I.ﬁ.lastri Licensing Dongle detected: 137 I

Extended Checkout -

Proxy Settings -

When can | pull out my dongle?
You should only pull out the dongle once the software has been shut down.

If unplugged while writing/reading, your unsaved data may be lost.

Dongle License Troubleshooting

There are times when dongles are not immediately recognised by the software or the computer. Take these steps
to check and resume the USB connection

Why is my dongle is flashing?
The dongle LED indicates the status of the dongle. In a normal state after the dongle is attached to the computer

the LED will be on all the time. If the LED blinks it indicates that the driver is not installed. Other LED responses
indicate hardware failure.



Why is my dongle recognised as an Unknown Device?

This problem occurs occasionally. Generally, your device is not attached properly to the computer, or some
interference exists. Remove your dongle and try to attach it again through a different USB port.

My computer recognises the dongle, but the application is still asking me to insert a dongle.
What do | do?

With the dongle inserted, exit, and restart the application.

Insert the dongle into a different USB port and restart the application.

With the dongle inserted, reboot your computer, and restart the application.
Insert a different dongle, then switch back.

Contact Alastri Support to exchange your dongle.
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